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1． OUTLINE
1.1 Foreword
This instruction manual describes installation and operation for the Parameter Loader of the
Paperless Recorder. Read it carefully before use.

1.2 Parameter loader
This Parameter Loader is software to do various settings of a Paperless Recorder with the personal
computer.
The setting preserved on the SD card with the main body of the Recorder can be read, and the
setting preserved on the SD card with this software can be read to the main body of the Recorder.
When you insert the SD card in the main body of the Recorder, the folder of the name called
“Recorder” is automatically made.
When you read and write the setting data with the main body of the Recorder, please preserve the
setting in the folder of “Prm” that exists under the folder of the name called “Recorder”.
(Refer item 2.4 for details.)

1.3 Contents of package
The following items are packaged with the product.
● CD-ROM for installation: 1
● Instruction manual which is installed to above CD-ROM

1.4 Recommended operating environment
● Microsoft Windows XP / Vista / 7 (32bit, 64bit)
The Loader is not run on Windows 95, 98, 2000, NT or Me.
● Hard disk with free capacity of 500MB or more
● Capacity of RAM necessary so that OS may operate normally
● Memory card. (SD card)
(Panasonic company 1～32GB or Sandisk company 1～32GB is recommended)
● PC made of maker
● The mouse and keyboard corresponding to OS
● The Ethernet communication port (10BASE-T, TCP/IP protocol)
● CD-ROM drive
● Display resolution of 1024×768 pixels (XGA) or more
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1.5 Install
1) If other application software programs are open, terminate all of them.
2) If the Parameter Loader has been already installed, open “Add/Remove Programs” on Control Panel
and delete the Parameter Loader.
3) Set CD-ROM in the personal computer drive.
4) The menu is automatically displayed. Follow the instructions on the screen. If the menu is not
displayed, please start “index.htm” that CD-ROM drive has. The menu for the installation is
displayed, and please installs it according to the instruction of the screen. The Data Viewer and the
Parameter Loader are installed at the same time.
5) A message is displayed, prompting you to verify that “Parameter loader setup is complete”.
Now, the Parameter Loader installation is completed.

1.6 Uninstall
Please uninstall the Parameter Loader by the following operations, and delete it according to the
instruction of Windows (Notes are included).
The Data Viewer and the Parameter Loader are uninstalled at the same time.
“START of Windows” ⇒ “Control Panel” ⇒ “Add/Remove Programs” ⇒ “VGR-B100”
When you install the differing version, before installing the upcoming version, please uninstall the
software that is now by the above-mentioned method. There is a possibility of not operating
normally.
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2． BASIC SETTING
2.1 Composition of setting display
Select “Programs” ⇒ “VGR-B100” ⇒ “Parameter Loader” from the Start menu.
①Menu bar

③Setting tab

②Tool bar

④Measured value
display area

⑤Scroll bar

①

②

③
④
⑤

Menu bar
The operation of the file and the setting of the language, etc. functions of the Parameter Loader
can be used.
Tool bar
The function often used is displayed as a shortcut key.
The set of tool bar cannot be changing.
Setting tab
The setting display can be changed by selected “③Setting tab”.
Measured value display area
Display the measured value. And, measured value can be changed by selecting each item.
Scroll bar
When the “④Measured value display area” overflows from screen, the display can be changed by
sliding “⑤Scroll bar”.
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2.2 Basic operation of setting screens
The basic operation of the setting screens is 4 methods.
①

When selecting contents to set by the other windows.

In this case, the channel select screen can be displayed by selects “Input type”.
Select the arbitrarily input type.
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②

When selecting contents to set by list.

In this case, the item of “RJC” is selected, and the item that can be selected as a list is displayed.
Select the arbitrarily item.

③

When setting contents by entering characters or numerical value.

In this case, when the “Description” is selected, the input of the character or the numerical value
becomes possible. Please input the arbitrarily description with the keyboard.

④

When setting contents by entering only numerical value.

In this case, when the ▲, ▼ button of “Z value” is selected, numerical value can be increased and
decreased. And the numerical value can be input directly with the keyboard.
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2.3 Operational expression
In the Parameter Loader, the following can be done by setting the operational expression.
1）＋、－、×、÷（Arithmetic operation）
Ex）Input “CH01 + CH02 - CH03”, and the result is output to CH13.
Ex）Input “CH04 * CH13 / K001”, and the result is output to CH20.
2）A complex operation can be done by the function prepared beforehand. (General operation)
Ex）The value of CH01 is requested by the involution of x, and the result is output to CH27.
(POW function)
Ex）The numerical value of the channel that indicates the largest value in the input value from
CH01 to CH12 is output to CH34. (MAXto function)
3）The sum total of the input value by the passage of time is calculated.（SUM operation）
Ex）The input value of CH02 is divided by 10, the value is added every 100ms, and the result is
output to CH41. (SUMsec function)
4）F value can be calculated. (F value operation)
Ex）The value input to CH03 and the value set by “F value” are used and calculated, and the
result is output to CH48. (FCAL funcion)
5）Two kinds of values can be outputted by the result of a logical operation table (Q exp. table).
Ex) When the result of the logical operation table Q001 is True(1), the value of CH01 is
outputted to CH48. When the result is False(0), the value of CH02 is outputted to CH48.
(Conditional branch)

In this case, when the “Calculating formula” is selected, the operational expression setting display
is displayed. (Refer item next page for details.)
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●Setting the calculation

expression
The expression can be set up to 3 items in each expression of S1 ～ S3.
Being reflected in the setting as a final operation result is Operation result of “Operational
expression”.
①Operational expression

②Operator name

⑥Range of
measurement
Clear button
⑦Operator button

⑧Input type

③Function tab

④Function button
SET button
⑤Description
display area

Operational expression
Display the operational expression is set.
② Operator name
Display the setting operator.
③ Function tab
The display of “④Function button” can be changed by selecting “③Function tab”.
①
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④

Function button
Select the “④Function button” to display the argument select display. The argument can be
inputted by selecting item and push the SET button.
After set, please register by OK button.
It can be set that selected only “①Operational expression”. As for the item under the selection, the
background becomes light blue.

⑧Input type

Description display area
When the cursor is matched to “④Function button”, the explanation of the function is displayed
in “⑤Description display area”.
⑥ Range of measurement
Display the range of measurement.
⑦ Operator button
The arbitrarily operator name can be set by selecting the “⑦Operator button”.
It can be set that selected only “②Operator name”. As for the item under the selection, the
background becomes light blue.
⑧ Input type
The input type can be set by selecting arbitrarily it from “⑧Input type”, and push the SET button.
It can be set that selected only “①Operational expression”.
CH
：Channel No. is specified, and input the value.
DI
：ON/OFF of the DI input is used for the operation as 1 and 0 of the numerical values.
Comm.：When the input is taken by the communication, the address is input.
Const. ：The numerical value set to the const table beforehand is input.
Exp. ：The operation result of the expression S1 ～ S3 is input as a numerical value.
ALM CH：ON/OFF of the alarm state is used for the operation as 1 and 0 of the numerical values. ※1
DO
：Output state of DO is used for the operation as 1 and 0 of the numerical values. ※1
⑤

2-6

Pulse ："1" is outputted when DI is set to ON from OFF. (Pulse width is 200ms.) ※1
※ To execute a pulse count, it is necessary to use a SUM function.
(Refer page 2-10 for SUM function.)
Q exp. ：Result of logical operation table is used for the operation as 1 and 0 of the numerical
values. ※1
Cond. ：The result of the logical operation table 1-100 is judged true(1) or false(0). When the
result is true(1), the argument A is outputted. And when the result is false(0), the
argument B is outputted. ※1
Timer ：The timer of “T01~T06, U1, U2” is input on the condition in the table below as reset
time of the operation result. ※2
※ Only the function for which “T” is specified can set the timer.（MAXtm、SUMhour function etc）
※1

It supports since software version 1.30.
※2 About T6 and U2, it supports since software version 1.30.
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●Setting the logical

operation table
Selection of [Q expression table] of [Calc. CH] will display Q expression input form (the
following figure).
The result of a logical operation expression can be used as a numerical value, or conclusion
conditions for the conditional branch "IF" by setting Arguments A, B and operator. (1 is outputted
when the result of a logical operation expression is right. 0 is outputted when not right.)
①Q exp. No.

②Operator

③Argument

④Logical operation

Clear button

⑤Operator button

⑥Input type

Q expression No.
Table number of the logical operation expression Q is displayed. [ ① Q expression No.]
corresponds with number of the conditional branch "IF".
(Example: Conditional branch IF100 uses the result of Q expression No.100)
② Operator
Display the setting operator. Only [⑤Operator button] can be chosen.
When AND, OR, NOT, and XOR are chosen, only Q expression can be used for [③Argument].
Moreover, when NOT are chosen, only “Argument A” can be set.
③ Argument
Display the setting argument. Only [⑥Input type] can be chosen.
④ Logical operation
The logical operation expression of each Q expression table is displayed.
①
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Operator button
Arbitrary operators can be set if [⑤Operator button] is chosen.
It can be set that selected only [②Operator]. As for the item under the selection, the background
becomes light blue.
⑥ Input type
If arbitrary input types are chosen from the item of [⑧Input type] and the SET button is pushed,
an input type can be set.
(It can be set that selected only [③Argument]. As for the item under the selection, the background
becomes light blue.)
※ Refer “●Setting the calculation expression” of page 2-6 for each input types.
⑤

●The example of

a logical operation table setting
Ex）The input value of CH01 and CH02 is compared. When input value of CH01 is larger than
CH02, the value which increased the input value of CH01 10 times is outputted to CH13.
Moreover, when input value of CH02 is larger than CH01, the value which decreased the
input value of CH02 10 times is outputted to CH13.

・In “Q expression input form”, it sets as follows.
Q100：“Operator：＞”, “Argument A：CH01”, “Argument B：CH02”.

・In “Calculating formula input form”, it sets as follows.
“S1：CH01 * K001(10)”, “S2：CH02/K001(10)”, “Calculating formula：IF001(S1, S2)”.
(A setting of a constant value K001 can be set up on the “Const. table” of a “Calc. CH”.)

If set up as mentioned above. When the value of CH01 is larger than the value of CH02, the
argument A of conditional branch IF001 (Exp; S1) is outputted to CH13. Moreover, when the value
of CH01 is equal or smaller than the value of CH02, the argument B of conditional branch IF001
(Exp; S2) is outputted to CH13.

2-9

●Kind and explanation of timer
Item
T01
T02
T03
T04
T05
T06
U1
U2
※

Range
1～9999(sec)
1～9999(min)
None
None
None
None
None
None

Content
Reset is executed at the cycle set by [Timer] of [Common Calc.]
Reset is executed at the cycle set by [Timer] of [Common Calc.]
Reset is executed at twelve o’clock (midnight) every day.
Reset is executed at twelve o’clock (midnight) of Sunday every week.
Reset is executed at twelve o’clock (midnight) of the first every month.
Reset is executed at every o'clock. (※)
Reset by DI. To set it, [U1] is selected by [DI] of [Others].
Reset by DI. To set it, [U2] is selected by [DI] of [Others]. (※)

It supports since software version 1.30.

●Kind and explanation of function

ABS

Argument
(※1)
(A)

Absolute value

The absolute value of the input value is output.

POW

(A,B)

Involution

It calculates, “B power of A”.

SQR

(A)

Square root

It calculates, square root of “A”.

LOG

(A)

LN

(A)

EXP

(A)

Common logarithm
Naturalized
logarithm
Index

RH

(A,B)

Relative humidity

It calculates, common logarithm of “A” (The bottom is a logarithm of 10.)
It calculates, naturalized logarithm of “A”.
(The bottom is a logarithm of “e”.)
It calculates, index of “e”.
When dry bulb temperature is “A” and wet bulb temperature is “B”,
relative humidity is calculated.
At this time, relative humidity uses the following conditions and
computes them in a formula of Sprung.
Conditions: Wind speeds of 2.5 m/s or more. The temperature of a dry
bulb and a wet-bulb is 0-100 degrees Celsius.

MAXin

(A,B)

MINin

(A,B)

MAXto

(A,B)

MINto

(A,B)

AVGto

(A,B)

MAXtm

(A,T)

MINtm

(A,T)

AVGtm

(A,T)

SUM

(A,T)

SUMsec

(A,T)

SUMmin

(A,T)

SUMhour

(A,T)

FCAL

(A)

Function
name

Name

Maximum value
(Between two input)
Minimum value
(Between two input)
Maximum value
(For continuous input)
Minimum value
(For continuous input)
Mean value
(For continuous input)
Maximum value
(Time series)
Minimum value
(Time series)
Mean value
(Time series)

Content

The maximum value of “A” and “B” is output.
The minimum value of “A” and “B” is output.
The maximum value from A to B is output.
The minimum value from A to B is output.
The mean value from A to B is output.
The maximum value is output at the interval time specified by “T”
when “A” is input.
The minimum value is output at the interval time specified by “T”
when “A” is input.
The mean value is output at the interval time specified by “T” when
“A” is input.

Integrated value
Integrated value
(Unit：sec)
Integrated value
(Unit：min)
Integrated value
(Unit：hour)
F value operation

RATE
PASSsec
PASSmin
PASShour
PASSday

(A,T)
-

Change volume
Progress time (sec)
Progress time (min)
Progress time(hour)
Progress time (day)

DEW

(A,B)

Dew point

The integrated value reset at the interval time specified by “T” is
output, when “A” is input.
The function is selected and used from the unit of input A.(※2)

The heat time (minute) needed to annihilate the microorganism in the
input of A is outputted.
The change volume of "A" is outputted with the time interval of "T". ※3
The count value of progress time is outputted. (sec) ※3 ※4
The count value of progress time is outputted. (min) ※3 ※4
The count value of progress time is outputted. (hour) ※3 ※4
The count value of progress time is outputted. (day) ※3 ※4
When dry bulb temperature is “A” and wet bulb temperature is “B”,
relative dew point temperature is calculated. ※3
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※1 A, B = All the input can be specified. T=Timer input(user reset is contained)
※2 The main body is measured with internal 100ms. Therefore, when you multiply the input value, it is not calculated
correctly by the difference of the unit of the input source. Therefore, it is necessary to change the function by the
unit of the input value.

As follows, table where “Timer unit” was compared with “Function name”, and example.
Timer unit

Function name

Calculation content

None
/s
/min
/h

SUM
SUMsec
SUMmin
SUMhour

∑(Measure value)
∑(Measure value / 10)
∑(Measure value / 600)
∑(Measure value / 36000)

Ex) When input the 20L/min,
SUM value of 1 minute.
12000
1200
20
0.333

It supports since software version 1.30.
※4 Refer item 7.25 of Paperless Recorder Manual (WXPVM70mnAR001E) for progress time.
※3

If the result of an operation of each function exceeds -32000 or 32000, a value becomes L / H over.

2.4 Folder composition of SD card
When the SD card is inserted in the main body of the recorder, the “Recorder” folder is
automatically made. “Recorder” folder contents are as follows.
［SD card folder composition］
[Recorder]-+-[Cap]
+-[Data]
+-[Etc]
+-[Prm]
1) Cap
The image taken by capture is preserved by bmp. The max preservation number is 100.
2) Data
The trend file measured with the main body is preserved. When the record begins, one new
folder is made, and a new folder is made while recording whenever 50 dm files are created.
※ Naming rule of folder name
Folder name：YYMMDDHHmmss
※

Naming rule
YY：year 2 digit (00～99)
MM：month 2 digit (01～12)
DD：day 2 digit (01～31)
HH：hour 2 digit (00～23)
mm：minute 2 digit (00～59)
xxxx：Record management file numbering 4 digit (0000～0999)
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Moreover, the content and the naming rule of the preserved file of each folder are as follows.
・Main record management file
It is a file that records “Trend data (main) record start time”, “Stop time”, and “Link information”.
By one "dm file", a "dmt file" manages to 50 file.
(If 50 or more "dmt files" are created, "dm file" is created newly.)
File name：xxxx_YYMMDDHHmm.dm
Extension：dm
・Main record trend file
It is a measurement data file divided at the file record cycle (main).
File name：xxxx_YYMMDDHHmm.dmt
Extension：dmt
・Main record event file
They are the history files of warning and the message, etc.
File name：xxxx_YYMMDDHHmm.dmt
Extension：dme
・Main record comment file
Data file of comment function. (It supports since recorder version 1.20.)
File name：xxxx_YYMMDDHHmm.dmt
Extension：dmc
・Sub record management file
It is a file that records “Trend data (sub) record start time”, “Stop time”, and “Link information”.
File name：xxxx_YYMMDDHHmm.ds
Extension：ds
・Sub record trend file
It is a measurement data file divided at the file record cycle (sub).
File name：xxxx_YYMMDDHHmm.dst
Extension：dst
3) Etc
The data of the character string table is preserved. (.txt)
The character string table can be used with the list key to the character input screen.
(Refer item 7.4 of Paperless Recorder Manual (WXPVM70mnAR001E) for Character Entry screen.)
4) Prm
Parameter configuration file (.dps) set with the main body of the recorder is preserved.
The “dps” file preserved in this folder can be read and written with the main body of the
recorder.
Please put the file generated with the parameter loader in this folder.
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2.5 The setting method of Modbus TCP connection
Writing and reading of a parameter can be performed with Modbus TCP connection.
(It supports since software version 1.20.)
Note）Only when the SD card is inserted in the recorder, reading and the writing of a parameter are
performed.
Select “File” ⇒ “Read parameters from the recorder” or “Write parameters to the recorder” from
the menu bar.
Then, connection with a paperless recorder is started.
※

Please match “IP Address” of Data Viewer and “IP Address” of Paperless recorder from
“Option” ⇒ “Communication” of the menu bar before it connects.
（IP Address of a Paperless recorder can be set from “System” ⇒ “Comm.” ⇒ “Ethernet1”.
Refer the following “ ● Example of setting IP Address” and “ ● Example of setting
telecommunication facility” for the details.)

●

Example of setting IP Address（Windows XP）
First of all, “Start menu” ⇒ ”Control Panel” ⇒ ”Network connection” is selected. And, ”Local
area connection” is Right-Clicked ⇒ Select the “Property”. Then, “Property of Local area
connection” is display.

Select the “Internet Protocol (TCP/IP)” ⇒ Because “Property of Internet Protocol (TCP/IP)” is
displayed when the “property” is clicked, “IP Address” and “Subnet mask“ is set. (In this case, “IP
Address” is set as “192.168.0.2”, and “Subnet mask” is set as “255.255.255.0”.)
※

Please inquire of the network administrator before setting “IP Address”, “Subnet mask” and
“Default gateway”, “DNS server address”. The trouble might occur in the network when the
setting is not correct.
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●

Example of setting telecommunication facility
When you select “View” ⇒ “Option” of the menu bar of the Parameter Loader.

The “IP Address” of “Modbus TCP Setting” and “FTP Setting” is set to become it as well as
“Paperless recorder (※Ethernet1)”. (In this case, “IP Address” is set as “192.168.0.1”.)
The “User” and “Password (It is omissible.)” of “FTP Setting” is set to become it as well as
“Paperless recorder (※FTP)”. (In this case, “User” is set as “user”.)
OK is selected and the setting is preserved.
※ Refer item 8.6 and 8.10 of “Paperless Recorder manual” for the “Ethernet1” and “FTP”.

Moreover, a maximum of 8 sets of communication setting of a recorder can be performed by
switching a tab.
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Completion of network connection will display the window (following figure).
※ The error occurs if the SD card has not been inserted in the recorder. Please try again after
inserting the SD card in the recorder.

In this case, if "No.1" is chosen and OK is pushed, the parameter set by the recorder will be read
into a Parameter Loader.
Moreover, the parameter set with the Parameter Loader can be written to a recorder by choosing
“File” ⇒ “Write parameters to the recorder” of a menu bar.
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3． SETTING PARAMETERS
3.1 Input CH
［Input CH］
Item
Input type
Burnout
RJC
RJC channel
Scaling
Meas. range(L)
Meas. range(H)
Scale range(L)
Scale range(H)
Decimal point
Unit
TAG
Description
Display color
Range of scale(L)
Range of scale(H)
Partitions

Setting contents

Set the input type.
Set the burnout function. (※1)
Select the RJC function. (※2)
Select the RJC channel. (1～48) (※3)
Set the scaling and square rooter. (※4)
Input the value of Meas. range (L). (※5)
Input the value of Meas. range (H). (※5)
Input the value of scale range (L). (-32000～32000) (※5) (※7)
Input the value of scale range (H). (-32000～32000) (※5) (※7)
Set the decimal point. (0～4) (※5)
Set the unit. (※5)
Input the TAG.
Set the comment for input channel.
Select the display color.
Input the range of scale (L). (-32000～32000) (※7)
Input the range of scale (H). (-32000～32000) (※7)
Input the value of partitions. (0～20)
Input the value of input filter (A time constant of the first order lag filter).
Input filter
(0～99)
Record type
Select the record type.
Offset
Input the value of offset. (-32000～32000) (※7)
Gain (%)
Input the value of gain. (-320.00～320.00)
Alarm Action
Select the action type.
DO No.
Select the DO No.
Alarm value
Input the alarm value. (-32000～32000) (※6) (※7)
Hysteresis(%)
Input the value of hysteresis. (0.0～100.00)
Alarm delay(sec) Input the value of alarm delay. (0～3600)
※1 Burnout function can only be set when the input type is “DC Voltage (mV)” or “TC”.
※2 RJC function can only be set when the input type is “TC”.
※3 RJC channel can only be set when the “RJC” is “Assignment channel”.
※4 Scaling can only be set when the input type is “DC voltage” or “DC current”.
(Scaling is not set when the input type is “TC” or “RTD”.)
※5 This item can only be set when the “Scaling” is “ON” or “Square root ON”.
※6 Alarm value cannot be set when the “Alarm Action” is “Fault”.
※7 The decimal point position is set by another item.
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3.2 Calc. CH
［Calc. CH］
Item
Setting contents
Decimal point
Set the decimal point. (0～4)
Unit
Set the unit.
TAG
Input the TAG.
Description
Set the comment for input channel.
Display color
Select the display color.
Range of scale(L) Input the range of scale (L). (-32000～32000) (※1)
Range of scale(H) Input the range of scale (H). (-32000～32000) (※1)
Partitions
Input the value of partitions. (0～20)
Input filter
Input the value of input filter. (0～99)
Record type
Select the record type.
Offset
Input the value of offset. (-32000～32000) (※1)
Gain (%)
Input the value of gain. (-320.00～320.00)
Alarm Action
Select the action type.
DO No.
Select the DO No.
Alarm value
Input the alarm value. (-32000～32000) (※1) (※2)
Hysteresis(％)
Input the value of Hysteresis. (0.0～100.00)
Alarm delay(sec) Input the value of Alarm delay. (0～3600)
※1 The decimal point position is set by another item.
※2 Alarm value cannot be set when the “Alarm Action” is “Fault”.
[Const table]
Item
Setting contents
No.
Display the const table No.
Value
Set the value of const table. (-32768～32767) (※1)
Decimal point
Set the decimal point of const table. (0～4)
※1 The decimal point position is set by another item.
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3.3 Common Calc.
［F value］
Item
Reference temp.
Z value
Start temp.

Setting contents
Input the value of reference temp. (-3200.0～3200.0)
Input the Z value. (-3200.0～3200.0)
Input the value of start temp. (-3200.0～3200.0)

［Timer］
Item
T1 timer(sec)
T2 timer(min)

Setting contents
Input the value of T1 timer. (1～9999)
Input the value of T2 timer. (1～9999)

3.4 Display
［Display］
Even each group 12CH can select it.
Item
Setting contents
Display
Select the display “ON”, “OFF”. (※)
Display name
Set the display name.
TAG disp set
Select the TAG display set.
Horizontal trend
The Horizontal trend display is “ON” and “OFF” is selected.
Vertical trend
The Vertical trend display is “ON” and “OFF” is selected.
Bar graph
The Bar graph display is “ON” and “OFF” is selected.
Digital display
The Digital display is “ON” and “OFF” is selected.
※ Display cannot be set when the “Group” is “Group1” or “Sub Group”.
［All ON/OFF］
Item
Group
Action
OK

Setting contents
Select the group No.
Operation to selected group No. is selected.
Start the operation.

［Auto

change］(It supports since software version 1.30.)
Item
Setting contents
Auto disp change
ON/OFF of a auto display function is chosen.
The cycle which switches a group is chosen from "5 sec", "10 sec", "15 sec",
Change cycle
"30 sec", and "60 sec".
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3.5 Record
［Action (Main)］
Item
Setting contents
Record cycle
Select the record cycle.
File rec cycle
Select the file rec cycle. (※1)
File overwrite
Select the file overwrite function, when SD card memory full. (※2)
※1 The range that can be selected by the item at the record cycle changes.
“100 ms” cannot be selected by the main record.
※2 Old data is deleted and operation is set when select the “ON”.
The record operation is stopped when the amount of the memory remainder is lost when select
the “OFF”.
Record cycle
1sec ～ 5sec
10sec ～ 1min
2min ～ 3min
5min ～ 30 min
60min

File rec cycle
1hour
1hour, 1day
1hour, 1day, 1week
1hour, 1day, 1week, 1month
1hour, 1day, 1week, 1month, 1year

［Action (Sub)］
Item
Setting contents
Sub rec cycle
Select the Sub record cycle.
Sub pre rec
Select the Sub pre record.
Sub rec timing
Select the Sub record timing.
DI No.
Select the DI No. ※
※ “DI No.” can only be displayed when the “Sub rec timing” is “DI”.
［Schedule Record］
Item
Schedule
Start Time
End Time
Day of the week

Setting contents
Select the schedule.
Input the value of start time.
Input the value of end time.
Select the week. (Plurals can be selected.)
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3.6 Others
［Edit of Unit］
Item
Unit

Setting contents
Input the unit.

［Message］
Item
Setting contents
Message
Input the message.
Timing
Select the timing of message is displayed.
DI No./CH No.
Select the DI number and CH number. (DI NO.:1～9, CH NO.:1～48) (※1)
Alarm No.
Select the alarm No. (1～4) (※2)
※1 These items can only be set when the “Timing” is “DI ON”, “DI OFF” or “ALM occurred”,
“ALM recovered”.
※2 “Alarm No.” can only be displayed when the “Timing” is “ALM occurred” or “ALM recovered”.
［DI］
Item
DI

Setting contents
Select the DI function.

［Progress

time］(It supports since software version 1.30.)
Item
Setting contents
Progress time
ON/OFF of a progress time display is chosen.
Condition
The conditions which start or stop the count of progress time are chosen.
DI No. / CH No.
Select the DI number and CH number. ※1
Alarm No.
Select the alarm number. ※2
※1 This item can only be displayed when the “Condition” is “DI” and “Alarm”.
※2 “DI No.” can only be displayed when the “Condition” is “Alarm”.
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3.7 Comm.
［Ethernet1］
Item
IP Address
Subnet Mask
Default GW
DNS address
［Ethernet2］
Item
Keep alive

Setting contents
Input the IP address.
Input the subnet mask.
Input the default GW.
Input the DNS address.

Setting contents
Select the keep alive function.

Keep alive cycle(min) Input the value of keep alive cycle. (10～240)

［SNTP］
Item
SNTP Func
SNTP address
Cal cycle time
(hour)
Get the time,
when power ON
Time zone (UTC)

Setting contents
Select the SNTP function.
Input the SNTP address.
Input the value of Cal cycle time. (1～200)
The function to acquire time when the power supply is turned on is “ON” and
“OFF” is selected.
Select the time zone.

［FTP］
Item
User name
Password
Level

Setting contents
Input the user name.
Set the password. (Can only use capital letter alphabet.)
Select the level.

3.8 Comm. 2
［Modbus］
Item
Operation
Station No.
Parity
Modbus TCP
Receive timeout
(min)

Setting contents
Select the operation of Modbus.
Input the value of station No. (0～247)
Select the parity function.
Input the time until timeout. (10～240 min)
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3.9 Device/Other
［LCD］
Item
Setting contents
Sleep time (min)
Input the value of sleep time. (0～60)
Action brightness Input the value of LCD active brightness. (2～5)
Sleep brightness
Input the value of LCD sleep brightness. (0～4)
LCD alarm
At the time of LCD OFF, if an alarm occurs, LCD is turned ON. (※)
Recovery
※ It supports since software version 1.20.

［Jump menu］
Item
JUMP Menu

Setting contents
The item added to the menu display is selected.

［Device］
Item
Setting contents
Operation mode
Select the operation mode.
FUNC key
Set the function key. (※1)
File format
Select the file format.
Language
Select the language of recorder. (※2)
Date format
Select the date format. (※2)
※1 “Addition reset” of this item supports since software version 1.20.
※2 This item cannot be set by a version that is newer than recorder version 1.10 or this. Please set it
with the recorder.
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4． SETTING MENUS
4.1 File
［File］
Item

Setting contents

New
Make the new file.
Open
Open the recording data.
Save
Save the current display status. (※1)
Save As
A present display is saved specifying the name and the preservation place. (※1)
Read parameters
Load the setting of the recorder by Modbus TCP. (※2)
from the recorder
Write parameters
Write the setting of the Parameter Loader to recorder by Modbus TCP. (※2)
to the recorder
Exit
End the Parameter Loader.
※1 When you insert the SD card in the main body of the recorder, the folder of the name called
“Recorder” is automatically made.
When you read and write the setting data with the main body of the recorder, please preserve the
setting in the folder of “Prm” that exists under the folder of the name called “Recorder”.
(Refer item 2.4 for details.)
※2 It supports since software version 1.20.

4.2 Edit
［Edit］
Item
Copy
Paste

Setting contents
The selected part is copied.
The copied part is put.

4.3 View
［View］
Item
Setting contents
Option
Set the setting that need to “Modbus TCP”. (Max 8) (※)
ToolBar
Select the “Display/non-display” of tool bar.
※ It supports since software version 1.20.
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4.4 Language
［Language］(※1)
Item
Setting contents
Japanese
Change the Japanese.
English
Change the English.
Czech
Change the Czech. (※2)
Chinese
Change the Chinese. (※2)
Korean
Change the Korean. (※3)
※1 It is necessary to reactivate the Parameter Loader to apply the change.
※2 It supports since software version 1.10.
※3 It supports since software version 1.11.

4.5 Help
［Help］
Item
About

Setting contents
Display the version of Parameter Loader.
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